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Introduction

This is a beginning to intermediate book on the statistical language and computing environment called R. As

you will learn, R is freely available and open source. Thousands of contributed packages are available from
members of the R community. In this book, you learn how to get R, install it, use it as a command-line interpreted
language, program in it, write custom functions, use it for the most common descriptive and inferential statistics,
and write an R package. You also learn some “newer” statistical techniques including bootstrapping and
simulation, as well as how to use R graphical user interfaces (GUIs) including RStudio and RCommander.

Who This Book Is For

This book is for working professionals who need to learn R to perform statistical analyses. Additionally, statistics
students and professors will find this book helpful as a textbook, a supplement for a statistical computing class,
or a reference for various statistical analyses. Both statisticians who want to learn R and R programmers who
need a refresher on statistics will benefit from the clear examples, the hands-on nature of the book, and the
conversational style in which the book is written.

How This Book Is Structured

This book is structured in 20 chapters, each of which covers the use of R for a particular purpose. In the first
three chapters, you learn how to get and install R and R packages, how to program in R, and how to write
custom functions. The standard descriptive statistics and graphics are covered in Chapters 4 to 7.

Chapters 8 to 14 cover the customary hypothesis tests concerning means, correlation and regression, and
multiple regression. Chapter 14 introduces logistic regression. Chapter 15 covers chi-square tests. Following
the standard nonparametric procedures in Chapter 16, Chapters 17 and 18 introduce simulation and the “new”
statistics including bootstrapping and permutation tests. The final two chapters cover making an R package and
using the RCommander package as a point-and-click statistics interface.

Conventions

In this book, we use TheSansMonoConNormalfont to show R code both inline and as code segments. The R code is
typically shown as you would see it in the R Console or the R Editor. All hyperlinks shown in this book were active
at the time of printing. Hyperlinks are shown in the following fashion:

http://www.apress.com

When you use the mouse to select from the menus in R or an R GUI, the instructions will appear as shown
below. For example, you may be directed to install a package by using the Packages menu in the RGui. The
instructions will state simply to select Packages » Install packages. .. (the ellipsis points mean that an
additional dialog box or window will open when you click Install packages).In the current example, you will
see a list of mirror sites from which you can download and install R packages.
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Downloading the code

The R code and documentation for the examples shown in this book and most of the datasets used in the book
are available on the Apress web site, www.apress.com. You can find a link on the book’s information page under
the Source Code/Downloads tab. This tab is located below the Related Titles section of the page.

Contacting the Author

Ilove hearing from my readers, especially fellow statistics professors. Should you have any questions or
comments, an idea for improvement, or something you think I should cover in a future book—or you spot a
mistake you think I should know about—you can contact me at larry@twopaces.com.
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CHAPTER 1

Getting R and Getting Started

Ris a flexible and powerful open-source implementation of the language S (for statistics) developed by John
Chambers and others at Bell Labs. R has eclipsed S and the commercially available S-Plus program for many
reasons. Ris free, and has a variety (nearly 4,000 at last count) of contributed packages, most of which are
also free. R works on Macs, PCs, and Linux systems. In this book, you will see screens of R 2.15.1 running in a
Windows 7 environment, but you will be able to use everything you learn with other systems, too. Although
Ris initially harder to learn and use than a spreadsheet or a dedicated statistics package, you will find R is a very
effective statistics tool in its own right, and is well worth the effort to learn.

Here are five compelling reasons to learn and use R.

e Risopen source and completely free. It is the de facto standard and preferred program
of many professional statisticians and researchers in a variety of fields. R community
members regularly contribute packages to increase R’s functionality.

e Risas good as (often better than) commercially available statistical packages like SPSS,
SAS, and Minitab.

¢ Rhas extensive statistical and graphing capabilities. R provides hundreds of built-in
statistical functions as well as its own built-in programming language.

e Risused in teaching and performing computational statistics. It is the language of choice
for many academics who teach computational statistics.

e  Getting help from the R user community is easy. There are readily available online
tutorials, data sets, and discussion forums about R.

R combines aspects of functional and object-oriented programming. One of the hallmarks of R is implicit
looping, which yields compact, simple code and frequently leads to faster execution. R is more than a computing
language. It is a software system. It is a command-line interpreted statistical computing environment, with its
own built-in scripting language. Most users imply both the language and the computing environment when they
say they are “using R” You can use R in interactive mode, which we will consider in this introductory text, and in
batch mode, which can automate production jobs. We will not discuss the batch mode in this book. Because we
are using an interpreted language rather than a compiled one, finding and fixing your mistakes is typically much
easier in R than in many other languages.

Getting and Using R

The best way to learn R is to use it. The developmental process recommended by John Chambers and the R
community, and a good one to follow, is user to programmer to contributor. You will begin that developmental
process in this book, but becoming a proficient programmer or ultimately a serious contributor is a journey that
may take years.
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If you do not already have R running on your system, download the precompiled binary files for your
operating system from the Comprehensive R Archive Network (CRAN) web site, or preferably, from a mirror site
close to you. Here is the CRAN web site:

http://cran.r-project.org/

Download the binary files and follow the installation instructions, accepting all defaults. Launch R by
clicking on the Ricon. For other systems, open a terminal window and type “R” on the command line. When you
launch R, you will get a screen that looks something like the following. You will see the label R Console, and this
window will be in the RGui (graphical user interface). Examine Figure 1-1 to see the R Console.

ﬁRGUE [ - . —— — — _“

File Edit View Misc Packages Windows Help
=@l [e]o] @l [&]

RRCUnsoIE ol =3 =)

R version 2.14.2 (2012-02-29)

Copyright (C) 2012 The R Foundation for Statistical Computing
ISEN 3-900051-07-0

Platform: i386-pc-mingw32/i386 (32-bit)

R is free software and comes with ABSOLUTELY NC WARRANTY.

You are welcome to redistribute it under certain conditions.

IType 'license()' or 'licence()' for distribution details.
Natural language support but running in an English locale

R is a collaborative project with many contributors.

Iype 'contributors()' for more information and

'citation()' on how to cite R or R packages in publications.

Iype 'demo()' for some demos, 'help()' for on-line help, or

'"help.atart()' for an HITML browser interface to help.

Iyvpe 'g()' to guit R.

[Previously s=saved workspace restored]

> |

Figure 1-1. The R Console running in the RGui in Windows 7

Although the R greeting is helpful and informative for beginners, it also takes up a lot of screen space. You
can clear the console by pressing<Ctrl>+ L or by selecting Edit » Clear console. R’s icon bar can be used to
open a script, load a workspace, save the current workspace image, copy, paste, copy and paste together, halt the

program (useful for scripts producing unwanted or unexpected results), and print. You can also gain access to
these features using the menu bar.

Tip You can customize your R Profile file so that you can avoid the opening greeting altogether. See the
R documentation for more information.

Many casual users begin typing expressions (one-liners, if you will) in the R console after the R prompt (>).
This is fine for short commands, but quickly becomes inefficient for longer lines of code and scripts. To open
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the R Editor, simply select File > New script. This opens a separate window into which you can type
commands (see Figure 1-2). You can then execute one or more lines by selecting the code you want to use, and
then pressing< Ctrl>+ R to run the code in the R Console. If you find yourself writing the same lines of code
repeatedly, it is a good idea to save the script so that you can open it and run the lines you need without having
to type the code again. You can also create custom functions in R. We will discuss the R interface, data structures,
and R programming before we discuss creating custom functions.

Reoi e

File Edit Packages Windows Help

RRCDHSDIE |_=l ‘l =] ” =

> |

‘R Untitled - R Editor =l ED)

Figure 1-2. The R Editor

A First R Session

Now that you know about the R Console and R Editor, you will see their contents from this point forward simply
shown in this font. Let us start with the use of R as a calculator, typing commands directly into the R Console.
Launch R and type the following code, pressing < Enter > after each command. Technically, everything the user

types is an expression.

>2 M2

[1]

> 2

TN S
N

[
>
[
>
[
>
[
>

~ O
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Like many other programs, R uses * for exponentiation, * for multiplication, / for division, + for addition,
and - for subtraction. R labels each output value with a number in square brackets. As far as R is concerned, there
is no such thing as a scalar quantity; to R, an individual number is a one-element vector. The [1] is simply the
index of the first element of the vector. To make things easier to understand, we will sometimes call a number like
2 a scalar, even though R considers it a vector.

The power of R is not in basic mathematical calculations (though it does them flawlessly), but in the ability
to assign values to objects and use functions to manipulate or analyze those objects. R allows three different
assignment operators, but we will use only the traditional <- for assignment.

You can use the equal sign =to assign a value to an object, but this does not always work and is easy to confuse
with the test for equality, which is ==. You can also use a right-pointing assignment operator - >, but that is not
something we will do in this book. When you assign an object in R, there is no need to declare or type it. Just assign
and start using it. We can use x as the label for a single value, a vector, a matrix, a list, or a data frame.

We will discuss each data type in more detail, but for now, just open a new script window and type, and then
execute the following code. We will assign several different objects to x, and check the mode (storage class) of
each object. We create a single-element vector, a numeric vector, a matrix (which is actually a kind of vector to R),
a character vector, a logical vector, and a list. The three main types or modes of data in R are numeric, character,
and logical. Vectors must be homogeneous (use the same data type), but lists, matrices, and data frames can all be
heterogeneous. I do not recommend the use of heterogeneous matrices, but lists and data frames are commonly
composed of different data types. Here is our code and the results of its execution. Note that the code in the R
Editor does not have the prompt > in front of each line

X <- 2

X

X "X

x N2

mode (x)

x <- c(1:10)

X

x "X

mode(x)

dim(x) <- c(2,5)

X

mode (x)

x <- c("Hello","world","!")
X

mode(x)

x <- c(TRUE, TRUE, FALSE, FALSE, TRUE, FALSE, TRUE)
X

mode(x)

x <- list("R","12345",FALSE)
X

mode (x)

Now, see what happens when we execute the code:

<- 2

[N [N N
_— S e X e X e X X
> B >N
N} P

a s~

e(x)

numeric"

o

1

N i e e B B A
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Note the “sequence operator” will produce the same result as c(1:10). You could produce a vector with
the numbers 1 through 10 by using seq(1:10). R provides the user the flexibility to do the same thing in many
different ways. Consider the following examples:

> seq(1:10)

[1] 2 2 3 4 5 6 7 8 910
> X <- c¢(1:10)

> X
[1] 2 2 3 4 5 6 7 8 910

> X M X
[1] 1 4 27 256 3125 46656
[7] 823543 16777216 387420489 10000000000

> mode(x)

[1] "numeric"
> dim(x) <- c(2,5)
> X

[,1] [,2] [,3] [,4] [,5]
[1,] 1 3 5 7 9
[2,] 2 4 6 8 10
> mode(x)
[1] "numeric"

Here is the obligatory “Hello World” code that is almost universally included in programming books and
classes:

> X <- ¢("Hello","world","!")

> X

[1] "Hello" "world" "!"

> mode(x)

[1] "character"

> x <- c(TRUE, TRUE, FALSE, FALSE, TRUE, FALSE, TRUE)
> X

[1] TRUE TRUE FALSE FALSE TRUE FALSE TRUE
> mode(x)

[1] "logical"

> x <- list("R","12345",FALSE)

> X

[[1]]

[1] "R"

[[2]]
[1] "12345"

[[3]]
[1] FALSE

> mode(x)
[1] "list"

List indexing is quite different from vector and matrix indexing, as you can see from the output above. We
will address that in more detail later. For now, let us discuss moving around in R.
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Moving Around in R

R saves all the commands you type during an R session, even if you have cleared the console. To see the previous
lines(s) of code, use the up arrow on the keyboard. To scroll down in the lines of code, use the down arrow. The left
and right arrows move the cursor in the current line, and this allows you to edit and fix code if you made a mistake.
Asyou have learned, you can clear the console when you want a clear working area, but you will still be able to
retrieve the entire command history. When you are finished with a session, you may want to save the workspace
image if you did something new and useful, or discard it if you were just experimenting or created something
worse than what you started with! When you exit R, using the q() function, or in Windows, File > Exit, the R system
will save the entire command history in your current (working) directory as a text file with the extension *.Rhistory.

You can access the R history using a text editor like Notepad. Examining the history is like viewing a
recording of the entire session from the perspective of the R Console. This can help you refresh your memory, and
you can also copy and paste sections of the history into the R Editor or R Console to speed up your computations.

Asyou have already seen, the R Editor gives you more control over what you are typing than the R Console
does, and for anything other than one-liners, you will find yourself using the R Editor more than the R Console.

In addition to saving the command history, R saves the functions, loaded packages, and objects you create
during an R session. The benefit of saving your workspace and scripts is that you will not have to type the
information again when you access this workspace image.When you exit R, you will see a prompt asking if you
want to save your workspace image (see Figure 1-3).

[ Question &J‘

el Save workspace image?

E Yes 3 [ No l l Cancel

W S

Figure 1-3. When you exit R, you will receive this prompt

Depending on what you did during that session, you may or may not want to do that. If you do, R will save
the workspace in the *.RData format. Just as you can save scripts, output, and data with other statistics packages,
you can save multiple workspace images in R. Then you can load and use the one you want. Simply find the
desired workspace image, which will be an *.RData file, and click on it to launch R. The workspace image will
contain all the data, functions, and loaded packages you used when you saved the workspace.

When you are in an R session, you may lose track of where you are in the computer’s file system. To find out your
working directory, use the getwd () command. You can also change the working directory by using the setwd (dir)
command. If you need help with a given function, you can simply type help(function), or use the ?function shortcut.
Either of these will open the R documentation, which is always a good place to start when you have questions.

To see a listing of the objects in your workspace, you can use the 1s() function. To get more detail, use
1s.str(). For example, here is the list of the objects in my current R workspace:

> 1s()

[1] "A" "acctdata" "address" "B" "b1"

[6] "balance" "c" "CareerSat" "chisquare” "colnames"
[11] "confint" "correctquant” "dataset"” "Dev" "grades”
[16] "Group" "hingedata" "hours" "it "Min_Wage"
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"newlist" "p"
"sorted" "stats"
"test2" "test3"
"Tscore" "Tscores"
z1" "zAge"

[21] "n" "names"

[26] "quizzes" "r"

[31] "TAge" "test1"

[36] "tests" "truequant”

[41] "x" "y" "
[46] "ztest1"

CHAPTER 1

GETTING R AND GETTING STARTED

"pie_data"
"stdev"
"testmeans"
ny
"zscores"

Let us create a couple of objects and then see that they are added to the workspace (and will be saved when/
if you save the workspace image).

> Examplel <- seq(2:50)

> Example2 <- log(Examplel)

> Example2

[1] 0.0000000 0.6931472 1.0986123 1

[8] 2.0794415 2.1972246 2.3025851 2
[15] 2.7080502 2.7725887 2.8332133 2
[22] 3.0910425 3.1354942 3.1780538 3
[29] 3.3672958 3.4011974 3.4339872 3
[36] 3.5835189 3.6109179 3.6375862 3
[43] 3.7612001 3.7841896 3.8066625 3
>

3862944 1.6094379
.3978953 2.4849066
.8903718 2.9444390
.2188758 3.2580965
4657359 3.4965076
.6635616 3.6888795
.8286414 3.8501476

.7917595 1.9459101
.5649494 2.6390573
.9957323 3.0445224
2958369 3.3322045
5263605 3.5553481
.7135721 3.7376696
.8712010 3.8918203

Now, see that 1s () will show these two vectors as part of our workspace. (This is a different workspace image
from the one shown earlier.) As this is a large workspace, I will show only the first screen (see Figure 1-4).

R = consoe (=1 Eo8 ==
> 1s() =
] R "A" "abc" "AbsDev"
[5] "acctdata" "addreass" "ana" bl - 1
[21 "B" ol 8 g "balance" "brand"
f13]. T "carbrands" "CareerSat” "ca New nbjects are
[17] "categories"™ "check" "checkprime® "ch .
[21] "chisquare™ "choices" "elassi® el v“;::;;2;?§nd
[25] ™class3" "classes" "colnames™ "co will be available | 4
[29] "confint" "correctquant® "count" Lole by 15
[33] “data" "dataset" "denom" "Dev
[37] "dummy" "dvlievel” "eguation” "erc™
[41] "ewv2® "ev3® "even" "Examplel"
[45] "Example2"” "expenses" "L "fm"
[49] "formatted_roots" "grade” "grades™ "grandtotal”™
[53] "Group"™ "hingedata” "hours" bl
[57] "input"™ "integera" "isprime"” b P
[61] "levels” "LL" "lvecl"” "lvec2"
[65] "m" "ml" "m2" "m3"
[69] "m4" "MAD" "MeanAbaDev" "mileage"
[73] "Mileage" "Min Wage" "my.mean" "my.var"
[T7] "n" "N "names" "newlistc"
[81] "newtitle” "newvector" "next level"” "nm"
[85] "number"™ "numeratorl"™ "numerator2™ "numeven™
[89] "numodd" "overall" npn "percapita®
[93]) "pie data”" "primes" "primetrue™ "primevec” o

Figure 1-4. Newly-created objects are automatically stored in the workspace

Now, see what happens when we invoke the 1s.str() function for a "verbose" description of the objects in the
workspace. Both our examples are included. The 1s.str() function gives an alphabetical listing of all the objects
currently saved in the workspace. We will look at the descriptions of only the two examples we just created.



CHAPTER 1 © GETTING R AND GETTING STARTED

> 1s.str()

1s.str()

Examplel : int [1:49] 123456789 10 ...
Example2 : num [1:49] 0 0.693 1.099 1.386 1.609 ...

Working with Data in R

As the creator of the S language, John Chambers, says, in most serious modern applications, real data usually
comes from a process external to our analysis. Although we can enter small amounts of data directly in R,
ultimately we will need to import larger data sets from applications such as spreadsheets, text files, or databases.
Let us discuss and illustrate the various R data types in more detail, and see how to work with them most
effectively.

Vectors

The most common data structure in R is the vector. As we have discussed, vectors must be homogeneous—that is,
the type of data in a given vector must all be the same. Vectors can be numeric, logical, or character. If you try to
mix data types, you will find that R forces (coerces, if you will) the data into one mode.

Creating a Vector

See what happens when you try to create a vector as follows. R obliges, but the mode is character, not numeric.

> x <- c(1, 2, 3, 4, "Pi")

> X
[1] "1“ l|2|l II3II Il4l| IIPiIl
> mode(x)

[1] "character"

Let us back up and learn how to create numeric vectors. When we need to mix data types, we need lists or
data frames. Character vectors need all character elements, and numeric vectors need all numeric elements. We
will work with both character and numeric vectors in this book, but let us work with numeric ones here. R has a
recycling property that is sometimes quite useful, but which also sometimes produces unexpected or unwanted
results. Let’s go back to our sequence operator and make a numeric vector with the sequence 1 to 10. We assign
vectors using the c (for combine) function. Though some books call this concatenation, there is a different cat()
function for concatenating output. We will discuss the cat() function in the next chapter. Let us now understand
how R deals with vectors that have different numbers of elements. For example, see what happens when we add
a vector to a different single-element vector. Because we are adding a "scalar” (really a single-element vector), R’s
recycling property makes it easy to "vectorize" the addition of one value to each element of the other vector.

> X <- c(1:10)
> X
[1] 1 2 3 4 5 6 7 8 910
> length(x)
[1] 10
>y <- 10
> length(y)
[1] 2
> X+y
[1] 22 12 13 14 15 16 17 18 19 20

8
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Many R books and tutorials refer to the last command above as scalar addition, and that much is true. But
what really matters here is that the command and its output are technically an implementation of R’s recycling
rule we discussed above. When one vector is shorter than the other, the shorter vector is recycled when you apply
mathematical operations to the two vectors.

Performing Vector Arithmetic

Ris very comfortable with adding two vectors, but notice what sometimes happens when they are of different
lengths, and one is not a single-element vector. Look at the output from the following examples to see what
happens when you add two vectors. In some cases, it works great, but in others, you get warned that the longer
object is not a multiple of the length of the shorter object!

>y <- c(o, 1)
>y
[1] 01
> X+y
[1] 2335577991
>y <- c(1,3,5)
> X+y
[1] 2 5 8 5 811 811 14 11
Warning message:
In x+y : longer object length is not a multiple of shorter object length

What is happening in the code above is that the shorter vector is being recycled as the operation continues.
In the first example, zero is added to each odd number, while 1 is added to each even number. R recycles the
elements in the shorter vector, as it needs, to make the operation work. Sometimes R'’s recycling feature is useful,
but often it is not. If the vectors are mismatched (that is, if the length of the longer vector is not an exact multiple
of the shorter vector’s length), R will give you a warning, but will still recycle the shorter vector until there are
enough elements to complete the operation.

Before we discuss vector arithmetic in more detail, let us look at a few more computations using our
example vector x:

> 2+3 * x #Note the order of operations

[1] 5 8 11 14 17 20 23 26 29 32

> (2+3) * x #See the difference

[1] 5 10 15 20 25 30 35 40 45 50

> sqrt(x) #Square roots

[1] 1.000000 1.414214 1.732051 2.000000 2.236068 2.449490 2.645751 2.828427
[9] 3.000000 3.162278

> X %% 4 #This is the integer divide (modulo) operation
[1TT1230123012

>y <- 3+21 #R does complex numbers

> Re(y) #The real part of the complex number

[1] 3

> Im(y) #The imaginary part of the complex number

[1] 2

>Xx ¥y

[1] 3+ 2i 6+ 41 9+ 61 12+ 8i 15+10i 18+12i 21+14i 24+161 27+181 30+201

Now that you understand working with numeric vectors, we are ready to explore additional vector
arithmetic. First, create a vector:

> X <- c(1:10) #Create a vector
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Note that the c() function is not really needed here, as my technical reviewer pointed out! You can
simply use:
> X <- 1:10

And get the same result. Following are some other possibilities, along with the results for x, y, and z.

>y <- seq(10) #Create a sequence

> z <- rep(1,10) #Create a repetitive pattern
> X

[1] 1 2 3 4 5 6 7 8 910

>y

[1] 2 2 3 4 5 6 7 8 910

>z

[1]111112112111

As mentioned previously, R often allows users to avoid explicit looping by the use of vectorized operations.
Looping implicitly through a vector is many times faster than looping explicitly, and makes the resulting R code
more compact. As you will learn in the following chapter, you can loop explicitly when you need to, but should
try to avoid this if possible. Vectorized operations on a single vector include many built-in functions, making R
powerful and efficient. It is possible to apply many functions to data frames as well, though not all functions “do”
data frames, as you will see. We can work around this by using other features and functions of R.

Although it takes some getting used to, R’s treatment of vectors is logical. As we discussed earlier, a vector
must have a single mode. You can check the mode of an object using the mode () function or using the typeof ()
function. As you have seen already in the output, R, unlike some other languages, begins its indexing with 1, not 0.

Adding Elements to a Vector

When you add elements, you are reassigning the vector. For example, see what happens when we append the
numbers 11:15 to our x vector:

> X <- c([1:10])
> X
[1] 1 2 3 4 5 6 7 8 910

Now, let us reassign x by adding the numbers 11 through 15 to it. We are taking x and then appending
(concatenating, in computer jargon) the sequence 11, 12, 13, 14, 15 to the 10-element vector to produce a
15-element vector we now have stored as x.

> X <- c(x, 11:15)
> X
[1] 1 2 3 4 5 6 7 8 910 11 12 13 14 15

Asyou already know, we can use the sequence operator to create a vector. We can obtain the length of the
vector with the length() function, the sum with the sum() function, and various statistics with other built-in
functions to be discussed and illustrated later. To make our example a little more interesting, let us imagine
a discrete probability distribution. We have a vector of the values of the variable and another vector of their
probabilities. Here is a very interesting distribution known as Benford’s Distribution, which is based on Benford’s
Law. The distribution gives the probability of first digits in numbers occurring in many (but not all) kinds of data.
Some data, such as financial data, are well described by Benford’s Law, making it useful for the investigation of
fraud. We will return to this example later when we have the background to dig deeper, but for now, just examine
the distribution itself. We will call the first digit V. Table 1-1 lists the first digits and their probabilities.
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